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Students with Disabilities:

For students with disabilities, the instructor should refer to the student's IEP to be sure that the accommodations specified are being provided. Having a copy of the students’ testing accommodations effectively informs the teacher of needed changes for students with disabilities effectively informs the teacher of needed changes for all tests.  Instructors should also familiarize themselves with the provisions of Behavior Intervention Plans that may be part of a student's IEP. Frequent consultation with a student's special education instructor will be beneficial in providing appropriate differentiation.
Reducing, shortening, or modifying assignments due to disability issues will be determined on a case by case basis.  Individual assistance opportunities will be provided as needed.   

Individual assistance opportunities provided as needed.  Students will learn to develop and plan independent of note skill techniques.  Students are required to be creative and descriptive in problem-solving skills.

All learners will be provided the strategies to maximize their learning potential.  Students who are gifted in areas will be challenged to stretch their thought processes.  Students with disabilities will be challenged and assisted to develop and expand skills as well.

Students will be provided guided practice, independent practice and peer support.  Order of problem resolution skills:  Refer to text, utilize Help button, ask a neighbor, ask the instructor.  When administering peer tutoring, do not touch your neighbor’s mouse.

[image: image2.jpg]% FOCUS STANDARDS




GPS Focus Standards: 
BCS-CA2-1
Students will use technology as a tool to increase productivity in completing a variety of input technologies to create, edit, and publish industry appropriate documents.
b)
Demonstrate appropriate handling and use of supplies and equipment. 

c)
Apply appropriate use of editing tools, e.g. spell check, thesaurus, find and replace, 
grammar, and hyphenation. 

d)
Demonstrate the use, movement, and display of a variety of icons, toolbars, and the 
task pane. 

e)
Demonstrate effective time-management to complete tasks in allotted time. 

f)
Utilize print options. 

BCS-CA2-4
Students will use database software to create, edit, and publish industry appropriate files. 
h)
Use and understand database splitter.

i)
Demonstrate report creation that involves summary options, calculated controls, and sub reports.

j)
Create and use queries to specify criteria such as calculated fields, group data, action queries, parameter queries, pivot tables, pivot charts, and aggregate functions.

k)
Create a database using multiple tables to establish relationship(s) between tables while maintaining referential integrity.
 
GPS Academic Standards:
ELA11W2
The student demonstrates competence in a variety of genres. 
MM3P3 

Students will communicate mathematically.
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Enduring Understandings: 
•
Use database software to create, edit, and publish industry appropriate files.

Essential Questions: 
•
What is the purpose of a macro, and how is one created?

•
How is a switchboard helpful in a database, and how do I create a switchboard?
•
What is a database splitter?  How and when is a database splitter used? 
•
How can I retrieve information from my database that gives me a listing of all LPNs, CNAs, and RNs that are working and additionally shows whether they are full time, part time or prn?
•
How can I create a report that includes calculations?
•
How are reports containing subreports created?
•
How can databases answer questions, group the answers, and perform calculations for answers?
•
How are action queries created and utilized?
•
How can a query be created that asks what criteria you would like included?
Knowledge from this Unit:  
Students will be able to identify and define: 
•
Macros
•
Switchboards and splitters
•
Calculated fields in queries/reports
•
Referential integrity
•
Pivot tables/charts

•
Relationships
Skills from this Unit:  
Students will be able to: 
•
Create and use macros and switchboards.
•
Use and understand database splitter

•
Report creation containing summary options/calculated controls and sub reports.

•
Create pivot charts/tables and aggregate functions.
•
Create a database with relationships established between tables while maintaining referential integrity.
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Assessment Method Type: 
	x
	Pre-test

	x
	Objective assessment - multiple-choice, true- false, etc.

	
	__ Quizzes/Tests

_x_ Unit test

	
	Group project

	x
	Individual project

	x
	Self-assessment - May include practice quizzes, games, simulations, checklists, etc.

	
	x__ Self-check rubrics   

__ Self-check during writing/planning process

_x_ Journal reflections on concepts, personal experiences and impact on one’s life

__ Reflect on evaluations of work from teachers, business partners, and competition judges

__ Academic prompts

__ Practice quizzes/tests

	
	Subjective assessment/Informal observations

	
	__ Essay tests

__ Observe students working with partners

__ Observe students role playing

	x
	Peer-assessment  

	
	__ Peer editing & commentary of products/projects/presentations using rubrics

__ Peer editing and/or critiquing

	x
	Dialogue and Discussion

	
	_x_ Student/teacher conferences
_x_ Partner and small group discussions

_x_ Whole group discussions
_x_ Interaction with/feedback from community members/speakers and business partners

	x
	Constructed Responses

	
	__ Chart good reading/writing/listening/speaking habits

_x_ Application of skills to real-life situations/scenarios

	x
	Post-test


Assessment Attachments and / or Directions: 
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•
LESSON 1:  MACROS

1.
Identify the standards. Standards should be posted in the classroom.
BCS-CA2-1
Students will use technology as a tool to increase productivity in completing a variety of input technologies to create, edit, and publish industry appropriate documents.

b)
Demonstrate appropriate handling and use of supplies and equipment. 

c)
Apply appropriate use of editing tools, e.g. spell check, thesaurus, find and replace, 
grammar, and hyphenation. 

d)
Demonstrate the use, movement, and display of a variety of icons, toolbars, and the 
task pane. 

e)
Demonstrate effective time-management to complete tasks in allotted time. 

f)
Utilize print options. 

BCS-CA2-4
Students will use database software to create, edit, and publish industry appropriate files. 
g)
Create and use macros and switchboards.

h)
Use and understand database splitter.

i)
Demonstrate report creation that involves summary options, calculated controls, and sub reports.

j)
Create and use queries to specify criteria such as calculated fields, group data, action queries, parameter queries, pivot tables, pivot charts, and aggregate functions.

k)
Create a database using multiple tables to establish relationship(s) between tables while maintaining referential integrity.
 
2.
Review Essential Question(s). Post Essential Questions in the classroom. 


•
What is the purpose of a macro, and how is one created?
3.
Identify and review the unit vocabulary. Terms may be posted on word wall.

	Macro
	Switchboard
	splitter

	Calculated control
	Parameter Query
	Action queries

	
	
	


4.
Interest approach – Mental set


Remind students that databases are being created for use by other people who may not be familiar with them.  Ask students for ideas that could be included in a database to make it easier for “untrained” people to use the database.  Lead the discussion toward macros and switchboards. 
5.
Using the attachment KWL, ask students to write what they think they know about macros and what they would like to know about macros.  

6.
Introduce students to the concept of macros by sharing with the students the Macros presentation.
7.
Explain that macros are shortcuts that can save time/steps.  

8.
Guide students through the creation of macros as outlined in the Creating Macros file.  

9.
Have students practice creating macros for their practice databases.  See Macros Database Project Instructions.
10.
Have students write what they have learned about macros on the KWL.
•
LESSON 2:  SWITCHBOARDS

1.
Review Essential Questions. Post Essential Questions in the classroom. 

•
How is a switchboard helpful in a database? How do I create a switchboard?
2.
Lead a general discussion on switchboards.  Have students relate what they know about switchboards in small groups, making notes of their uses.  After reviewing the students’ knowledge of switchboards, relate the switchboard concept to databases.

Switchboard uses:


•
Helps get you to the appropriate department.


•
Usually does so quickly.


•
What does a switchboard look like?

•
Etc.

3. 
Share the Switchboards presentation with students.  Have students take notes for the vocabulary definitions included in the presentation.
4.
After viewing and explaining the Switchboards presentation with students, guide students through the creation of a switchboard using the Creating a Switchboard file.  

5.
For practice, create switchboards for the Technicians Database for the macro that was created previously.  Also, create a switchboard for the macros that were created in the Resort Rentals Database Assignment.
•
LESSON 3:  DATABASE SPLITTERS 

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
What is a database splitter?  How and when is a database splitter used? 
2.
Bring to class a splitter for cable TV for a demonstration.  Ask students to explain to you or discuss in small groups how the cable TV splitter works.  (Journal about the cable splitter.)
3. 
Relate databases to the cable TV signal coming into the house.  Only one person can watch cable TV in the house unless a splitter is utilized to split the signal to different TVs.
4.
Utilizing the Database Splitters presentation, explain what a database splitter is, when it is used, and why.

5.
Guide students through the process of splitting a database.  Make a copy of your nursing home database and use the copy to complete the exercises.

6.
Independent practice:  Have students copy the Resort Rentals Database and split the database.  Assessment is teacher observation during process. 
•
LESSON #4:  REPORTS WITH SUMMARY OPTIONS

1.
Review Essential Questions. Post Essential Questions in the classroom. 

•
How can I retrieve information from my database that gives me a listing of all LPNs, CNAs, and RNs that are working and additionally shows whether they are full time, part time or prn?
2.
Have students brainstorm ideas of how to get this specific information from the database.

3.
Show students the PowerPoint Reports in Access-Summary Options.
4. 
Lead students to the report option.  Explain that reports can be created using a wizard.
5.
Demonstrate to students how to create a report based on the Employee table.  Include the First Name, Last Name, Status, and Title fields in the report.  Have students group the data first by Title and then by Status.  Use the Outline format for the report.  Select the Concourse style.  Name the report Employee Title-Status Report. 

6.  
Note that the report is created and employees are grouped first by their Title and then by their employment status within the title.  This is an example of a report that involves summary options.

7.  
For independent practice, have students create a summary report for the Resort Rentals Database.  Base it on the Renters table.  Include the First Name, Last Name, Rental Unit Name, First Night fields.  Group the report by the Rental Unit Name and then further group it by the First Night date.   Have the students include their name in the report title and print the report.
•
LESSON #5:  REPORTS WITH CALCULATED CONTROLS

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
How can I create a report that includes calculations?
2.
Have students brainstorm ideas of how to get this specific information from the database.

3.  
Explain to students that there are times when adding calculated data will be extremely beneficial.  Unless specifically instructed, reports do not calculate data.  
4.
Review the Reports with Calculated Controls PowerPoint presentation with students.

5.
Using the Shelves Done Right Database as a demonstration, guide students through the process of creating a report two different ways – clicking Report button and by using the Report Wizard.
6.
When creating one with the report wizard, base it on the customers table.  Include the fields salesman no., customer no., customer name, and balance.  Add grouping by salesman no.

7.  
Have students note that the customers are grouped according to their salesman no.

8.
It would be great to know how much each salesman has in outstanding fees.  This is where we will add a calculated control to each salesman’s section.

9.
In layout view, direct students’ attention to the three new tabs:  Format, Arrange, and Page Setup.

10.
Make sure the Format tab is selected.  Right click on the first dollar amount in the Balance column.  Select Total Balance and then sum.  This feature will add a total for each salesman as well as provide a total sum for all amounts due from all salesmen.

11.
When working in layout view, Access uses the right control for you.  Allow students to select other options on the Total Balance sub menu to see each option’s effect on the data.  Remind students to end the task on the sum option.
12.
Demonstrate to students how to change the size of columns in layout view.  
13.
Demonstrate to students how to filter data using the filter button located on the Home tab.  This is also done in layout view.  Discuss the various options with students.  Have them leave Salesman No. 215 off of the report.  Demonstrate to students how to clear the filters – shortcut menu – Clear filter . . .

14.  
Instruct students to click the save button before exiting the report.

13.
Using the Nursing Home Database for extra practice, have the students create a report that lists all of the according to their title (1st grouping option) and status (2nd grouping option) -- full time employees, part time employees, prn, and terminated employees.  Have them add grouping to the report grouping them by status.  Allow the students to decide which information is most important to create this report.  We are only concerned with names.  After creating the report, have the students enter a calculated field that counts the number of employees in each grouping and also gives an overall total number of employees.  Have the students omit the employees whose status is TERM from the report.  This may be evaluated by teach observation, printing, or electronic submission.
•
LESSON #6:  SUBREPORTS

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
How are reports containing subreports created?
2.
As a bell ringer, to reinforce skills and to prepare for the day’s activities, have the students create a query containing all fields based on the Customer table in the Sportsmanship database.  Then have students create a query containing all fields based on the Order table in the Sportsmanship database.  Direct students to save the reports as Customer and Orders, repectively.

3.
Relate today’s learning to previous learning – including a subform in a form.  

4.
Open the Customers Report in design view.  In the Report Footer section, direct students to extend the viewable area via the double-headed arrow.  On the Design tab, click the subform/subreport button.  Draw an area in which the subreport will show.  Upon releasing the mouse, the wizard will begin.  Use an existing report.  Select Orders report.  Direct the wizard to select your own criteria.  Link using the Customer ID fields in both reports.  Finish the wizard and view the report in layout view.  Notice that only one order is shown in the window.  Right click on the customer ID number in the report itself (not subreport) and click the numbers equal filter.  Type in 6.  Note that the report changes and only shows customer ID number 6 in both the report and subreport.  All students to experiment with changing the customer numbers.  Also allow students to experiment with removing all filters.
5.
Assessment:  Using the Shelves Done Right database, have students create a report for the Customers table and another report for the Salesmen table.  Then have the students include the Salesmen report as a subreport in the Customer report.  Have them practice applying filters, aggregate functions, etc., in the layout view.

•
LESSON #7:  QUERIES WITH CALCULATED FIELDS AND GROUPING

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
How can databases answer questions, group the answers, and perform calculations for answers?
2.
As a bell ringer, to reinforce skills and to prepare for the day’s activities, have the students enter the employees’ salaries into the Nursing Home database using the Employee Form.  Salaries are found in the Employee Salaries spreadsheet that is attached. 

•
Have students give examples of questions that might be asked of databases.  

Examples:

· Which clients’ names begin with Be?

· Which clients have a $0 balance due?

· Which clients have a balance of more than $500.00?

3.
Explain the definition of query – a question formatted in a way that Access can understand.  To answer a question, a query must be created.

4.
Show students Creating a Query PowerPoint presentation.

5.
Using the Nursing Home database, demonstrate creating a simple query using the Query Wizard.  

6.  
Make sure the fields First Name, Last Name, Title, Status and Salary are included.  Name the query Employee Query.  While reviewing, have students note that terminated employees are included in the query.  We want only current employees in our report.  Additionally, let’s restrict the information to CNAs.  Demonstrate to using design view to modify the query to exclude specific data from a query – exclude TERM status and restrict data to CNA titles only.  

7. 
Demonstrate to students uses of wildcards (symbols that r4epresent any character or combination of characters) -- * represents one or more characters and ? represents only one character.  Sq* would locate all Squires, Squat, Squash, etc.  J?m would include Jim, Jam, etc.
8.
Have students create a query finding all active employees whose last names begin with the letter S – should use the * wildcard.

9.
To demonstrate a calculated control in a query, present the students with this scenario:  They are the administrator of the nursing home and want to give all CNAs a raise of .75 per hour.  You want to know the new salary amount of all CNAs after the.75.  Demonstrate creating a calculated field in the Employee Query using the expression builder.  Additionally, have the students sort the query in ascending order by Last Name.  Allow the students to view the Query, noting that the field name for the calculated field does not adequately reflect the calculations.  Demonstrate renaming the field to ProjSalCNA.  When renaming the field, remind students that the colon separates the caption from the actual expression – the colon needs to remain in the field caption.
10.
Have the students create a report based on the Employee Query with the Projected Salaries for CNAs and add a total for the CNA salaries, since you would like to know the total cost of the salary increase to your nursing home.  Demonstrate to students how to use the property sheet to change the formatting of the Projected Salaries for CNAs to Currency and also how to change the column width of the fields in the report – Layout View.  Also, demonstrate changing the title of the Report to Projected CNA Salary Increase.
11.
For practice and assessment, the students now want to calculate salary projects for RNs that are not terminated.  Their projected salary increase will be $1.00 per hour.  Create a query that includes all active RNs, RNs’ names, current salary, status, and a calculated field for their projected new rate of pay.  Students should then create a report based on the RN query, add a total to the report, and format the projected salary to currency.  Also, have students change the title of the report and column widths as appropriate.  See RN Calculated Query Checksheet.
•
LESSON #8:  ACTION QUERIES

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
How are action queries created and utilized?
2.
Allow students to speculate as to the uses of action queries.  Lead discussion toward performing an action – appending data to a table, update information, delete data, etc.

3.
Demonstrate and guide students in appending a table to another table in the Sportsmanship Database.  Note there is a Prospective Customer table in the Sportsmanship database.  These prospective customers are now customers.  Rather than typing the new customers name in the new table, we would like to append the Prospective Customers table to the Customer table.  Note that only the fields that have field names alike will be appended.  When students create a tables, make sure they follow this rule.  On the Create tab, select Query in Design.  This will open the design view for creating a query.  We want to add the table Prospective Customers to choose the fields from.  Select all of the fields to be shown in the query design grid.  Once all of the fields have been selected, click the Append button on the design tab.  Then click the Run (!) button.  It tells you that two records will be appended and gives you the option to stop.  Continue.  Open the Customers table.  The two new records should be in the table.  

4.
Another type of query is the Make New table query.  Again, use the design view to create a query.  Use the Prospective Customer table and all fiends in it.  This time click the Make New Table button.  The dialog box will prompt you for the new table.  Call it Sample.  Open the Sample table to see that the two records in the Prospective Customer table are now in the new table.
5.  
Delete Action Query – Again, create an action query in Design View.  Use the Sample table this time and select all fields.  This time use the Delete action button.  Opening the Sample table will reveal that there are no records in the table.

6.
As a summarizing activity, have the students journal about the three different action queries created, comparing and contrasting the different actions.

•
LESSON #9:  PARAMETER QUERIES

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
How can a query be created that asks what criteria you would like included?
2.
Review the creation of the CNA Projected Salary Query and the RN Projected Salary Query.  Explain that we had to create a 2nd query when we wanted to retrieve the RN data.  
3.
Define parameter query to students – query that prompts the user for an input when it is used.  Relate to projected salary queries.  Explain that a query can be created that asks which group of employees should be included.  CNAs? RNs? LPNs?

4.
Demonstrate creation of a parameter query by opening the CNA Projected Salary query.  Under the Title field, remove the CNA criteria and type in “[Enter Title].”  Type the criteria without the quotation marks.

5.
For assessment and practice, students should use the Sportsmanship Database and create a query based on the Customer table that includes all fields.  Direct the students to enter a parameter query to restrict data by city.  First have students run the query with customer located in Quitman.  Then run the query again for customer located in Rose City.  Save the Query as Customers by Location.
•
LESSON #10:  AGGREGATE FUNCTIONS 

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
What is an aggregate function and how is it created and utilized?

2.
Lead a discussion on the meaning of the word aggregate.  Lead a discussion of the word function and relate it to mathematical functions. 

3.
 Demonstrate to students how to add an aggregate function to the Orders table of the Sportsmanship database – Click the total button and in the proper field, click the drop-down arrow to select the function:  sum, min, max, etc.  To remove the function, click the totals button again.

4.
Demonstrate adding an aggregate function to a query – after the query has run, click the totals button.  Then select the drop-down arrow in the appropriate field and choose the aggregate function you would like to include.  Note the options change based on the data type contained in the fields.  If the salaries column doesn’t offer mathematical functions, the data type is not set to number or currency.  Make those changes and rerun the query.  Note in fields containing text, the aggregate function option is “count.”

5.
Observe students creating a query on the Orders table of the Sportsmanship database and adding an aggregate function showing the average order amount.
•
ATTACHMENTS FOR LESSON PLANS

Lesson 1:
•
KWL
•
Macros

•
Creating Macros 
•
Macros Database Project Instructions

Lesson 2: 

•
Switchboards

•
Creating a Switchboard
•
Resort Rentals Database Assignment
Lesson 3: 

•
Database Splitters
Lesson 4: 

•
Reports in Access-Summary Options
Lesson 5: 
•
Reports with Calculated Controls
•
Shelves Done Right Database
Lesson 6: 

•
Sportsmanship Database
•
Shelves Done Right Database
Lesson 7: 

•
Employee Salaries
•
Creating a Query
•
RN Calculated Query Checksheet
Lesson 8: 

•
Sportsmanship Database
Lesson 9: 

• 
Sportsmanship Database
Lesson 10: 

•
Sportsmanship Database
•
NOTES & REFLECTION: 
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Culminating Unit Performance Task Title: 
Travel Database Creation
Culminating Unit Performance Task Description/Directions/Differentiated Instruction: 
Instructions are included in the Performance Assessment Instructions.
Attachments for Culminating Performance Task: 
•
Performance Assessment Instructions
•
Performance Assessment Rubric
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Web Resources:
Materials & Equipment: 
21st Century Technology Used: 
	x
	Slide Show Software
	
	Graphing Software
	
	Audio File(s)

	
	Interactive Whiteboard
	
	Calculator
	
	Graphic Organizer

	
	Student Response System
	
	Desktop Publishing 
	
	Image File(s)

	
	Web Design Software
	
	Blog
	
	Video

	
	Animation Software
	
	Wiki
	
	Electronic Game or Puzzle Maker

	
	Email
	x
	Website
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